
User's Manual

Unauthorized copying or transferal, in whole or in part, of this manual is
prohibited.

The contents of this operation manual and the specifications of this product
are subject to change without notice.

The operation manual and the product have been prepared and tested as
much as possible. If you find any misprint or error, please inform us.

Roland DG Corp. assumes no responsibility for any direct or indirect loss
or damage which may occur through use of this product, regardless of any
failure to perform on the part of this product.



* Windows(R) and Windows NT(R) are registered trademark or trademark of Microsoft(R) Corporation in the United States
and/or other countries.
* TrueType is a trademark of Apple Computer, Inc.
* Pentium is a registered trademark of Intel Corporation in the United States.
* CorelDraw is a trademark of Corel Corporation.
Other company names and product name are trademarks or registered trademarks of their respective holders.

Copyright (C) 1999-2001 Roland DG Corporation



1

Table of Contents

Part 1 What's Dr. STIKA PLUS.......................................................................................................4

1-1 System Requirements ...................................................................................................................................... 4

1-2 Overview of Dr. STIKA PLUS ....................................................................................................................... 4

1-3 Names and Functions of Screen Items ............................................................................................................ 5

Part 2 Operation Procedures ............................................................................................................6

2-1 Introduction ..................................................................................................................................................... 6

2-2 Set the cutting area .......................................................................................................................................... 6

2-3 Set the cutting conditions ................................................................................................................................ 8

2-4 Enter the text ................................................................................................................................................... 9

2-5 Change the size of the text .............................................................................................................................. 9

2-6 Choose a font................................................................................................................................................... 9

2-7 Make a square frame ..................................................................................................................................... 10

2-8 Save the file ................................................................................................................................................... 10

2-9 Start cutting ................................................................................................................................................... 10

2-10 Apply the sticker ......................................................................................................................................... 11

Part 3 Basic Operations for Objects...............................................................................................12

3-1 Selecting an object ........................................................................................................................................ 12

3-2 Canceling the selection of an object.............................................................................................................. 12

3-3 Moving an object horizontally or vertically .................................................................................................. 12

3-4 Making an object larger or smaller................................................................................................................ 13

3-5 Rotating an object.......................................................................................................................................... 13

3-6 Slanting an object .......................................................................................................................................... 14

3-7 Copying an object.......................................................................................................................................... 14

3-8 Deleting an object.......................................................................................................................................... 14

Part 4 Hints and Tips.......................................................................................................................15

4-1 Shapes Unsuitable for Cutting....................................................................................................................... 15

4-2 Changing the size without altering the centerpoint ....................................................................................... 16

4-3 Creating a shape with the same vertical and horizontal aspect ..................................................................... 16

4-4 Creating a shape with the drag start point as the center ................................................................................ 17

4-5 Editing the points (apices) of a polygon........................................................................................................ 17

4-6 Selecting an object hidden under another object ........................................................................................... 19

4-7 Arranging a number of objects -- Using Snap to Grid .................................................................................. 19

4-8 Aligning the centers of a number of objects.................................................................................................. 20

4-9 Creating regular polygons ............................................................................................................................. 20

4-10 Using symbols ............................................................................................................................................. 21

4-11 Pasting a graphic created with commercial software into Dr. STIKA PLUS.............................................. 21

4-12 Making use of existing Dr. STIKA PLUS data ........................................................................................... 21

4-13 Using a scanner to import an object ............................................................................................................ 22

4-14 Importing bitmap data ................................................................................................................................. 23



2

4-15 Outputting data larger than the cutting area ................................................................................................ 24

Part 5 Commands.............................................................................................................................25

5-1 Toolbar buttons ............................................................................................................................................. 25

5-2 [File] menu .................................................................................................................................................... 27
[File] - [New] command .................................................................................................................................. 27
[File] - [Open...] command .............................................................................................................................. 27
[File] - [Save] command.................................................................................................................................. 27
[File] - [Save As...] command.......................................................................................................................... 27
[File] - [Import] command............................................................................................................................... 27
[File] - [Select Source...] command................................................................................................................. 27
[File] - [Acquire...] command.......................................................................................................................... 28
[File] - [Print...] command............................................................................................................................... 28
[File] - [Print Preview] command.................................................................................................................... 28
[File] - [Print Setup...] command..................................................................................................................... 28
[File] - [Tiling] command................................................................................................................................ 28
[File] - [Exit] command ................................................................................................................................... 29

5-3 [Edit] menu.................................................................................................................................................... 30
[Edit] - [Undo] command ................................................................................................................................ 30
[Edit] - [Cut] command ................................................................................................................................... 30
[Edit] - [Copy] command................................................................................................................................. 30
[Edit] - [Paste] command................................................................................................................................. 30
[Edit] - [Delete] command............................................................................................................................... 30
[Edit] - [Select All] command ......................................................................................................................... 30

5-4 [View] menu.................................................................................................................................................. 31
[View] - [Zoom] - [Zoom In] command.......................................................................................................... 31
[View] - [Zoom] - [Zoom Out] command ....................................................................................................... 31
[View] - [Zoom] - [Custom] command ........................................................................................................... 31
[Select Zoom] dialog box ................................................................................................................................ 31
[View] - [Toolbar] command........................................................................................................................... 31
[View] - [Object Info] command..................................................................................................................... 32
[View] - [PenColor] command ........................................................................................................................ 32
[View] - [Status Bar] command....................................................................................................................... 32
[View] - [Show Grid] command...................................................................................................................... 32
[View] - [Snap To Grid] command.................................................................................................................. 32
[View] - [Grid Setup...] command................................................................................................................... 32
[Grid Setup] dialog box ................................................................................................................................... 33

5-5 [Object] menu................................................................................................................................................ 34
[Object] - [Text] command.............................................................................................................................. 34
[Object] - [Rectangle] command ..................................................................................................................... 34
[Object] - [Round Rectangle] command.......................................................................................................... 34
[Object] - [Ellipse] command .......................................................................................................................... 34
[Object] - [Star] command............................................................................................................................... 34
[Object] - [Polygon] command........................................................................................................................ 35
[Object] - [Symbols] command ....................................................................................................................... 35
[Symbol] dialog box ........................................................................................................................................ 35
[Object] - [Add Symbol] command ................................................................................................................. 36
[Add Symbol] dialog box ................................................................................................................................ 36
[Object] - [Properties] command ..................................................................................................................... 36
Text Properties................................................................................................................................................. 37
Rectangle properties ........................................................................................................................................ 38
Round rectangles Properties ............................................................................................................................ 39
Circle or ellipse properties............................................................................................................................... 40
Star properties.................................................................................................................................................. 41
Polygon properties ........................................................................................................................................... 42
[Object] - [Font] command.............................................................................................................................. 42



3

[Font Select] dialog box................................................................................................................................... 43
[Object] - [Text Style] command..................................................................................................................... 43
[Object] - [Text Style] - [Horizontal] command.............................................................................................. 43
[Object] - [Text Style] - [Vertical] command.................................................................................................. 43
[Object] - [Move To Front] command............................................................................................................. 44
[Object] - [Move To Back] command ............................................................................................................. 44
[Object] - [Align] command ............................................................................................................................ 44
[Object] - [Mirror] command........................................................................................................................... 44
[Object] - [Convert to Polygon] command ...................................................................................................... 44
[Object] - [Combine Polygon] command ........................................................................................................ 44
[Object] - [Break Apart] command.................................................................................................................. 45

5-6 [Help] menu................................................................................................................................................... 45
[Help] - [Contents] command.......................................................................................................................... 45
[Help] - [About...] command ........................................................................................................................... 45

Part 6 If You Think There's a Problem... ......................................................................................46

6-1 Dr.STIKA PLUS doesn't function................................................................................................................. 46

6-2 Uncut areas remain, or areas are not cleanly cut. .......................................................................................... 46

6-3 The results of cutting are displaced, and uncut portions ............................................................................... 46

6-4 Error Messages.............................................................................................................................................. 47

Appendix...........................................................................................................................................48

Glossary............................................................................................................................................................... 48



4

Part 1 What's Dr. STIKA PLUS

1-1 System Requirements

- Microsoft(R) Windows(R) 95, Windows 98, Windows Me, Windows NT(R) 4.0, Windows 2000, or Windows
XP operating system
- The minimum required CPU for the operating system (Pentium(R) or higher recommended)
- The minimum amount of required RAM for the operating system (32 Mbytes or more recommended)
- 5 Mbytes or more of free hard disk space for installation

1-2 Overview of Dr. STIKA PLUS

Dr. STIKA PLUS is a Windows application for making stickers.

Main Features of Dr. STIKA PLUS

- Text outlining (TrueType fonts)

- Changing the thickness (weight) of text

- Creating squares, circles, stars, and other shapes

- Inserting and registering a symbol

- Editing shapes and text (objects)
- Changing the size of an object
- Rotating an object
- Slanting an object to the left or right
- Flipping the object laterally (Mirror function)
- Editing the points (apices) of a polygon

- Precise object positioning (Show Grid function)

- Tiled cutting for sizes larger than the cutting area (Tiling function)

- Importing image data from image scanners with TWAIN support

- Importing files in BMP (Windows bitmap) format (Bitmap Trace function)
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1-3 Names and Functions of Screen Items

(1) Title bar
The file name and program name are displayed here.
The window can be moved by dragging the title bar.

(2) Menu Bar
Runs the various commands for Dr.STIKA PLUS.

(3) Toolbar
The toolbar is provided with buttons for running Dr.STIKA PLUS commands such as [Open...] and [Save].
Moving the mouse pointer over a button displays a brief description of the button's function.

(4) Cutting direction
This shows the direction of cutting with respect to the cutting machine.

(5) Cutting Area
This white square indicates the cutting range set by the driver. Objects that extend beyond this area are not cut.

(6) Object Information Bar
This shows the location of the mouse pointer, as well as the centerpoint, size, angle, and slant of the object.

(7) Status Bar
This shows the type of text font, line color, and amount of zoom in or zoom out for the image.

(8) Object
This is a shape or a block of text to be cut.

(9) Minimize button
This shrinks the window to a button on the taskbar.

(10) Maximize button / Restore button
This expands the window to fill the screen.
To restore the window size, click again.

(11) Close button
This ends the program.
If changes made to the file being edited have not been saved, a dialog box asking if you wish to save the changes
is displayed.
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Part 2 Operation Procedures

2-1 Introduction

The basic operation of Dr. STIKA PLUS is covered in the explanation of the procedures from 2-2 to 2-10. This
section describes how to cut the sticker shown in the figure.

2-2 Set the cutting area

Set the cutting area to match the size of the material loaded.

The cutting range that has been set becomes the editing area for Dr. STIKA PLUS. The editing area is represented
by a shadowed white rectangle. A sticker is designed by arranging shapes and text in the editing area. Portions
that extend beyond this area are not cut.
The material loaded on the cutting machine has some places that cannot be cut, such as the portion that passes
under the pinch rollers and the portion corresponding to the length required for sheet feed.
Set values for the cutting area that are smaller than the size of the loaded material.
The cutting area varies from one model to another. For more information, see the user's manual for the cutting
machine you're using.

< Procedure >

For Windows Me/98/95

1. From the [File] menu, click [Print Setup].
The [Print Setup] dialog box is displayed.

2. For [Printer], click [Name], then choose the driver to be used for output.

3. Click [Properties].
The driver's properties open.

4. Set the cutting range.

5. Click [OK].
The driver's properties close.

6. Click [OK].
The [Print Setup] dialog box closes.

For Windows XP/2000/NT 4.0

To output cutting data, choose from among the registered material sizes, then perform output.

1. From the [File] menu, click [Print Setup].
The [Print Setup] dialog box is displayed.

2. For [Printer], click [Name], then choose the driver to be used for output.

3. Click [Paper Size] and choose the cutting range.

4. Click [OK].
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If the size you want does not appear in the selections displayed in step 3, use the following method to register the
cutting range (material size). When registering the new material size, log on as the member of a group
[Administrators].

1. From the [File] menu, click [Print Setup].
The [Print Setup] dialog box is displayed.

2. For [Printer], click [Name], then choose the driver to be used for output.

3. Click [Properties].
The driver's properties open.

4. If you're using Windows XP/2000, go to the [Layout] tab and click [Advanced].
If you're using Windows NT 4.0, click the [Advanced] tab.

5. If you're using Windows XP/2000, click [Media Size Settings], then click [Properties].
If you're using Windows NT 4.0, go to [Document Options] and click [Media Size Settings], then click the
[Work Size Settings] button.
The [Media Size Settings] dialog box appears.

6. Click [Add New Media Size].

7. Set the cutting range.

8. In [Media Size Name], enter a name for registering the material size, then click [OK].
Use only alphanumeric characters to enter the name.

9. Click [OK].
This closes the driver's properties.

10. Click [OK].
The [Print Setup] dialog box closes.

――――――――――――――――――――
About the Cutting-start Position

The position where cutting starts varies according to the model.
When you are arranging an object in a portion of the specified cutting range, arrange it as shown below according
to the model you're using.

- SX/STX Series
Arrange the object in the top portion of the cutting area. Perform cutting, starting from the far

(innermost) end of the loaded material



8

- Cutting Machine Other Than the SX/STX Series
Arrange the object in the bottom portion of the cutting area. Perform cutting, starting from the near

(frontmost) end of the loaded material

――――――――――――――――――――

Next, make the settings for the cutting conditions.

2-3 Set the cutting conditions

Set the transfer speed of the blade and the tool offset to match the type of blade installed and the type of material
loaded. This section describes the procedures to set [Machine Setting]. For more details about setting the cutting
conditions, refer to the help screens for the driver.

< Procedure >

For Windows Me/98/95

1. Open the driver's properties.

2. Click the [Tool] tab.

3. Click [Setting], and choose [Machine Setting].

4. Click [OK].

For Windows XP/2000/NT 4.0

* When setting up the cutting conditions, log on as the member of a group [Administrators].

1. Open the driver's properties.

2. If you're using Windows XP/2000, click [Advanced].
If you're using Windows NT 4.0, click the [Advanced] tab.

3. Click [Select Tool], then choose [Machine Setting].

4. Click [OK].
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2-4 Enter the text

Enter the block of text to be cut.
The text that is input is displayed as outlined text. Only TrueType fonts registered with Windows can be used with
Dr. STIKA PLUS. Here we'll input SALE as the block of text.

< Procedure >

1. Click the  button.
The mouse pointer changes to the cursor for the text-editing tool (  ).

2. Click at the start point for entering the text.

3. Type in SALE from the keyboard.

2-5 Change the size of the text

Change the size of the text.
In this section we'll enlarge the size the SALE text to match the size of the material.

< Procedure >

1. Click the  button.
The mouse pointer changes from the text-entry tool (  ) to the selection tool (  ).

2. Click on the SALE text.
Editing points (  and  ) appear around the text.

3. Drag a  with the mouse.
The size of the text changes as the mouse moves. Here, change the text to a size that fills the white area, as
shown below, then release the mouse button.

4. To deselect the text, click on an area other than the text.

2-6 Choose a font

Choose a font for the entered text.
With Dr. STIKA PLUS, you cannot use any font other than TrueType fonts registered in Windows. When
selecting a font, only TrueType fonts are listed.

< Procedure >

1. Click on the text to select it.

2. From the [Object] menu, click [Font...]. The [Font Select] dialog box is displayed.

3. Click on the font name to select it.
Here, we'll select Arial.
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2-7 Make a square frame

The sheet can be made easier to peel after it has been cut by cutting all around the shapes and text. In this section
we'll draw a rectangular frame to enclose the SALE text.

< Procedure >

1. Click the  button.
The mouse pointer changes from the selection tool (  ) to the shape-drawing tool (  ).

2. Drag the pointer as shown in the figure.

2-8 Save the file

Save the data that's been created to a file.

< Procedure >

1. Click the  button.
The [Save As] dialog box appears.

2. Enter the name of the file and click [Save].

2-9 Start cutting

Operate Dr. STIKA PLUS and start cutting. Before cutting, check the cable connections, the loading of the
material, and the installation of the blade. For more details, please refer to the user's manual for the cutting
machine.

< Procedure >

1. Click the  button.
The [Print] dialog box appears.

2. Click [OK].
The cutting data is sent to the cutting machine, and cutting starts.

To cancel cutting before it's finished

1. On the cutting machine, switch off the power.

2. On the computer, click [Start].

3. Open [Printers] or [Printers and Other Hardware] folder.

4. Double-click the icon for the printer driver.

5. From the [Printer] menu, click [Purge Print Jobs] or [Cancel].
(If you're using Windows XP/2000, choose [Cancel All Documents].)
The file being cut is deleted from display. When the file being cut is not displayed, it means that the data has
already been sent.
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2-10 Apply the sticker

Apply the sticker that's been cut it the desired location. Application tape is used to apply the sticker.

< Procedure >

1. Remove the material on the cutting machine.

2. Peel off the excess parts of the sheet. It may be easier to peel off detailed portions of the cut sheet using
ordinary tweezers (not included).

3. Cover carefully with application tape so that no air is trapped between, and transfer the sheet to the tape.

4. Carefully wipe away any grime (dust or oil) on the place where the sticker is to be applied.

5. Apply the application tape with the sticker to the desired site, and press from above. A commercially available
squeegee can be used to apply the sticker attractively, with no air bubbles under the sheet. Make sure the
sticker is affixed to the target object, then slowly peel off the application tape.
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Part 3 Basic Operations for Objects

3-1 Selecting an object

1. Click the  button.

2. Move the mouse cursor to the object (shape or text) to be selected, and click the mouse.

3. The symbols  and  appear around the selected object.

Selecting more than object
- While holding down the [Shift] key, click on each of the objects you wish to select.
- Drag the mouse to enclose entirely the object you wish to select.

3-2 Canceling the selection of an object

1. Click the  button.

2. Click on an area other than the selected object.

3-3 Moving an object horizontally or vertically

1. Click the  button.

2. Click on the object to select it.

3. While holding down the [Shift] key, drag the object up, down, or to the left or right.
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3-4 Making an object larger or smaller

1. Click the  button.

2. Click on the object to select it.

3. Change the size of the object by dragging the points (  and ) that appear around the object.
The size can be freely changed by dragging a square point ( .) The size can be changed while maintaining the
shape's vertical and horizontal aspect by holding down the [Shift] key while dragging.

The triangular points ( ) on the left and right can be dragged to change the horizontal size.

 

The triangular points ( ) above and below can be dragged to change the vertical size.

3-5 Rotating an object

1. Click the  button.

2. Click on the object to select it.

3. Click on the object again.
The points around the object change to circles and diamonds (  and  ).

4. Drag a circular point (  ) to rotate the object.
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3-6 Slanting an object

1. Click the  button.

2. Click on the object to select it.

3. Click on the object again.
The points around the object change to circles and diamonds (  and  ).

4. Drag a diamond point (  ) to slant the object.

3-7 Copying an object

1. Click the  button.

2. Select the object to be copied by clicking on it.

3. Click the  button.

4. Click the  button.
The new object is copied overlapping the source object.

5. Select the copied object and drag it to the desired location.

3-8 Deleting an object

1. Click the  button.

2. Select the object to be copied by clicking on it.

3. From the [Edit] menu, click [Delete].
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Part 4 Hints and Tips

4-1 Shapes Unsuitable for Cutting

The following shapes are not suitable for cutting. This should be kept in mind when creating shapes with Dr.
STIKA PLUS.

Open shapes

A shape whose start point and end point do not coincide is called an "open shape." An open shape is not suitable
for cutting, because the sheet cannot be peeled off after the shape has been cut.

Partially overlapping shapes

Data like that in the figure below, where two shapes partially overlap, is not suitable for cutting. Objects should be
arranged so that shapes do not overlap.

Even in cases of overlapping shapes, a shape that is completely enclosed inside another is suitable for cutting.
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4-2 Changing the size without altering the centerpoint

To change the size without altering the position of its centerpoint, hold down the [Ctrl] key and drag an editing
point (  or  ).

1. Select the object

2. While holding down the [Ctrl] key, drag a point (  or  ).
The size can be freely changed by dragging a square point (  ).

The size can be changed while maintaining the shape's vertical and horizontal aspect by holding down the
[Shift] key while dragging.

 

The triangular points (  ) on the left and right can be dragged to change the horizontal size.

The triangular points (  ) above and below can be dragged to change the vertical size.

4-3 Creating a shape with the same vertical and horizontal
aspect

To create a shape with a vertical/horizontal aspect of 1:1, such as a circle or square, drag while holding down the
[Shift] key. This function is not supported when creating text or a polygon.

1. Click the button for creating a rectangle, round rectangle, circle or ellipse, or star.

2. While holding down the [Shift] key, drag the object.
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4-4 Creating a shape with the drag start point as the center

To create a shape with a shape's start point the centerpoint, drag while holding down the [Ctrl] key. This function
is not supported when creating text or a polygon.

1. Click the button for creating a square, rounded-corner square, circle or ellipse, or star.

2. While holding down the [Ctrl] key, drag the object.

4-5 Editing the points (apices) of a polygon

You can use the polygon edit button (  ) to add, delete, or move the points in a polygon.

Selecting a point

1. Click .

2. Click on the polygon.

3. Click on the point.
The selected point changes to a square with a border (  ).

Selecting a number of points

1. Click .

2. Click on the polygon.

3. Hold down the [Shift] key and click on each point (  ). Alternatively, drag the mouse over the points to be
selected. Each selected point changes to a square with a border (  ).

Selecting a segment

A polygon shown as a series of continuous lines is called a segment.

1. Click .

2. Click on the polygon.

3. While holding down the [Ctrl] key, click on one point (  ) on the segment. All of the segment's points change
to a square with a border (  ).

4. To select a number of segments, hold down the [Shift] key and the [Ctrl] key and click on each point (  ).
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Moving a point

1. Click .

2. Click on the polygon.

3. Drag the point (  ).

When a number of points have been selected, you can move them as a set while still maintaining their positions in
relation to each other. To move a number of points, drag any one of the selected points (  ).

Adding a point

1. Click .

2. Click on the polygon.

3. Move the mouse pointer over a line of the polygon, then click.
A (  ) appears where the point will be added.

4. Press [Insert].
To add a point using only the mouse, double-click on a line of the polygon.

Deleting a point

1. Click .

2. Click on the polygon.

3. Click on the point.
The selected point changes to a square with a border (  ).
To delete two or more points at the same time, hold down the [Shift] key as you click on each point (  ).
Alternatively, drag the mouse over the points to be deleted.

4. Press [Delete].
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4-6 Selecting an object hidden under another object

All objects maintain a certain front-to-back relationship when they overlap. This hierarchy depends on the
sequence in which the objects were created, with newer objects existing more to the front than older ones. When a
smaller object lies behind a larger one, the smaller object cannot be selected. To select the smaller object, change
the front-to-back relationship of the larger and smaller objects. This front-to-back relationship between objects
can be changed at any time.

1. Select the large circle on top

2. Click the  button.
The large circle moves to the bottom.

3. Select the small circle

4-7 Arranging a number of objects -- Using Snap to Grid

It's possible to use a grid as a guide for placing and sizing objects. The grid is shown on screen with equal vertical
and horizontal spacing. When Dr. STIKA PLUS has just been installed, the grid is shown with a spacing interval
of 5 mm. To align an object with the grid, from the [View] menu, activate [Snap To Grid].

1. Create the object at any location.

2. From the [View] menu, select [Snap To Grid].

3. Select the objects one at a time, and move each object toward the grid at the desired location. The object is
automatically pulled to the grid and aligned.

When the text blocks are aligned with the left-hand edge
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4-8 Aligning the centers of a number of objects

It's necessary to align objects at their centers when making a sticker that has text surrounded by a border, or when
creating centered text.

Aligning objects at their centers

1. Create the objects at any location.

2. Select all of the objects whose centers you wish to align.

3. From the [Object] menu, click [Align]. The centerpoints of the selected objects are all aligned.

Centering text

1. Create two or more blocks of text, then carry out steps 2 and 3 for "Aligning objects at their centers."

2. Select one block of text, and while holding down the [Shift] key, drag the selected text up or down. Follow the
same procedure to align the other blocks of text.

4-9 Creating regular polygons

A regular polygon can be created by first making a circle, then modifying it.

1. Click the  button.

2. While holding down the [Shift] key, drag the mouse to create a circle.

3. Select the circle, then from the [Object] menu, click [Properties]. The [Object Property] dialog box appears.

4. Drag the [Shape] slider.
You can make any regular polygon having from three sides (an equilateral triangle) to thirteen. Dragging the
slider to the right-hand edge creates a circle instead of a polygon.
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4-10 Using symbols

Dr. STIKA PLUS is provided with a set of symbols. Symbols can be added to a file being edited, or registered
with Dr. STIKA PLUS objects.

Importing a symbol

1. From the [Object] menu, click [Symbol].
The [Symbol] dialog box appears.

2. Select the group, then click on the symbol to be added.

3. Click [Insert].

4. Adjust the size and position of the symbol to be placed.

Registering a symbol

1. Select the symbol to be used, and click [Insert].

2. From the [Object] menu, click [Symbol].
The [Add Symbol] dialog box appears.

3. Register the symbol with an appropriate group according to use or shape. To create a new group, click [New
Group] and enter a name for the group. When adding the symbol to an existing group, select the group name
with [Group Name].

4. At [Symbol Name], enter a name for the symbol. Then click [Add].

4-11 Pasting a graphic created with commercial software into
Dr. STIKA PLUS

You can copy data created with software such as CorelDRAW! that uses vector data, and paste the data into Dr.
STIKA PLUS using the clipboard. The data pasted in can then be edited just like any ordinary object.

Conditions for data that can be pasted
- Don't include bitmap data
- Don't fill or apply shading inside shapes
- Set line width to the finest (narrowest) available setting

1. After using a commercial software application to create data, select the data and copy it.
For information on how to create data with the commercial software application, refer to the documentation for
the software you are using.

2. From the [Edit] menu, click [Paste]. The copied data appears in Dr. STIKA PLUS.

4-12 Making use of existing Dr. STIKA PLUS data

An object saved in another file can be added to the file for the object now being edited. This makes it possible to
re-use objects that have been previously created and saved.

1. From the [File] menu, click [Import...]. The [Open] dialog box appears.

2. Click [Files of type] and select [Dr. STIKA Files (*.stx)]. A list of files that can be imported is shown.

3. Select the file and click [Open].

4. The imported objects are shown on screen. The newly appearing data can be edited in the same way as ordinary
data.
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4-13 Using a scanner to import an object

An image acquired with a scanner can be imported into Dr. STIKA PLUS and outlined for cutting. Dr. STIKA
PLUS supports scanners that comply with TWAIN_32. For information on connecting the scanner and installing
the scanner driver, please refer to the scanner's documentation.

Some images cannot be outlined easily, or may produce shapes that are not suitable for cutting. Please keep the
following conditions in mind when creating data.

< Conditions for data that yields attractive cutting results >

- Boundaries between two colors should be sharp and well defined, with no continuous gradations. Using
only the two values of white and black is recommended.
(Scanned data for photographs generally contains continuous gradations, making it unsuitable for cutting.)

<Example>

 

- The scan resolution should be high.
(In general, a higher resolution yields outlining of greater accuracy. The optimal resolution varies according to a
shape's complexity and size when cut. However, it takes longer to import high-resolution data into Dr. STIKA
PLUS than low-resolution data.)

<Example>

- The size of the original art being scanned should be the same as the size when cutting.
(Results of cutting that are more attractive than the original art are not obtained when an image smaller than the
cut image is imported and then enlarged with Dr. STIKA PLUS. To help ensure attractive results of cutting, start
with a larger object and reduce it to the desired size.)

< Procedure >

1. From the [File] menu, click [Select Source...].

2. Select the driver for the scanner.
If a TWAIN driver and a TWAIN_32 driver are both installed, select the TWAIN_32 driver.

3. Load the original document on the scanner.

4. From the [File] menu, click [Acquire...]. Launch the scanning software. For information on how to do this,
please refer to the documentation for the scanner.

5. When the scanning is finished, the scanned data is imported into Dr. STIKA PLUS. The [Preview] dialog box
appears. Make sure the information in the dialog box is correct and click [OK].

6. Check the scanned data in the [Preview] dialog box and click [OK].

7. The outlined object appears on screen.
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4-14 Importing bitmap data

Dr. STIKA PLUS support import for files in Windows bitmap format (which have the file extension *.bmp). For
information on how to save a file in Windows bitmap format, please refer to the documentation for the software
application.

Some images cannot be outlined easily, or may produce shapes that are not suitable for cutting. Please keep the
following conditions in mind when creating data.

< Conditions for data that yields attractive cutting results >

- Boundaries between two colors should be sharp and well defined, with no continuous gradations. Using
only the two values of white and black is recommended.
(Scanned data for photographs generally contains continuous gradations, making it unsuitable for cutting.)

<Example>

 

- The resolution should be high.

<Example>

- The size of the image should be the same as the size when cutting.
(Results of cutting that are more attractive than the original art are not obtained when an image smaller than the
cut image is imported and then enlarged with Dr. STIKA PLUS. To help ensure attractive results of cutting, start
with a larger object and reduce it to the desired size.)

< Procedure >

1. From the [File] menu, click [Import...]. The [Open] dialog box appears.

2. Click [Files of type] and select [Windows Bitmap File (*.bmp)]. A list of files that can be imported is shown.
Select the desired file and click [Open...].

3. The data is read into the preview screen and displayed. Check the contents and click [OK]. When importing a
color image, outlining may not proceed as expected, depending on the colors. In such cases, drag the [Adjust
Image Density] slider to adjust the image, or refer to the "Conditions for data that yields attractive cutting
results" to correct the data using a commercial software application.

4. The outlined object appears on screen.
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4-15 Outputting data larger than the cutting area

The Tiling function is used when cutting data that exceeds the maximum cutting area on a single piece of material.
Using the Titling function lets you set a cutting area that is twice the size of the cutting area set with the driver.
The data is split and is cut on two pieces of material.

When tiling is used, a line is cut between the right-hand edge of the first page and the left-hand edge of the second
page, as in the tiled output shown in the figure.

This is done to close any shapes that extend across the first and second pages. The cut length of this line is the
length for the cutting area that has been set for the driver. This means that loading material that is shorter than the
cutting range may result in the material coming loose during cutting. Be sure to load material that is longer than
the cutting range that has been set.

< Procedure >

1. The two pages of material are shown divided by a dotted line.

2. Create the cutting data.

3. Click the  button.
A message appears, prompting you to load the material.

4. Load the material for the first page and click [OK].

5. When finished sending the data for the first page, Dr. STIKA PLUS displays a message prompting you to
change the material. Make sure the cutting machine has stopped operation and load the second piece of
material.

6. After changing the material, click [OK]. The cutting for the second page starts.
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Part 5 Commands

5-1 Toolbar buttons

The toolbar is provided with buttons for running Dr.STIKA PLUS commands such as [Open...] and [Save].
Moving the mouse pointer over a button displays a brief description of the button's function.
The buttons provided on the toolbar are as shown below. Click on a button's icon to display an explanation of the
command.

New
This creates a new file.

Open
This opens a Dr.STIKA PLUS file.

Save
This saves the file, overwriting the previous version of the file.

Print
This takes the cutting data displayed on the edit screen and outputs it to the cutting machine.

Cut
This deletes the selected object, and copies it to the clipboard.

Copy
This copies the selected object to the clipboard.

Paste
This copies the contents of the clipboard, pasting them at the selected on-screen location.

Select Object
This selects an object.
To select an object, move the mouse pointer over the object and click.

Edit Polygon Vertices
This is use to move the position of a polygon's apices, changing the polygon's shape. Click this button,
then position the mouse over the polygon and click. The polygon's apices (  ) are displayed. Clicking on
an object other than a polygon cancels the polygon edit mode. Dragging a polygon pointer (  ) changes
the position of the apex.

Draw Text
This is used to enter a block of text to be cut.
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Draw Rectangle
This is used to create a square or rectangle by dragging to the desired location.

Draw Rounded Rectangle
This is used to create a square or rectangle with rounded corners by dragging to the desired location.

Draw Ellipse
This is used to create a circle or ellipse by dragging to the desired location

Draw Star
This is used to create a star by dragging to the desired location.

Draw Polygon
This is used to create a polygon by clicking on the apices.

Zoom In / Out
This enlarges or reduces the view of the object. Clicking the left mouse button show an enlarged view with
the point where clicked at the center. The area to be enlarged can also be specified by dragging with the
mouse. Clicking the right mouse button shows a reduced-size view.

Move to Back
This changes the front-back relationship of the objects.

Move to Front
This changes the front-back relationship of the objects.

Horizontal Text
The selected block text of text changes to a horizontal layout.

Vertical Text
The selected block text of text changes to a vertical layout.
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5-2 [File] menu

[File] - [New] command

This creates a new file.
If changes made to a file being edited have not been saved, a dialog box asking if you wish to save the changes is
displayed.

 Tool bar：
 Keyboard shortcut: [Ctrl]+[N]

[File] - [Open...] command

This opens a Dr.STIKA PLUS file.
Running this command opens the [Open] dialog box.
If changes made to a file being edited have not been saved, a dialog box asking if you wish to save the changes is
displayed.

 Tool bar：
 Keyboard shortcut: [Ctrl]+[O]

[File] - [Save] command

This saves the file, overwriting the previous version of the file.
To save the file with a different name or in a different area, use the [Save As...] command

 Tool bar：
 Keyboard shortcut: [Ctrl]+[S]

[File] - [Save As...] command

This saves the file with a different name.
Running this command opens the [Save As] dialog box.
Normally, ".stx" is used as the file extension.

[File] - [Import] command

This imports an existing Dr. STIKA PLUS file, or a file created using another software application. Running this
command makes the [Open] dialog box appear.

[File] - [Select Source...] command

This selects the scanner connected to the computer. Dr. STIKA PLUS supports scanners that comply with
TWAIN_32. For information on connecting the scanner and installing the scanner driver, please refer to the
scanner's documentation.
If a TWAIN driver and a TWAIN_32 driver are both installed, choose the TWAIN_32 driver.
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[File] - [Acquire...] command

This takes in the image from the scanner. The acquired image can then be outlined with Dr. STIKA PLUS and cut.
Running this command launches the application for performing scanning. For more information on operation,
please refer to the scanner's documentation.

[File] - [Print...] command

This takes the cutting data displayed on the edit screen and outputs it to the cutting machine. Running this
command opens the [Print] dialog box. To output data, then for [Printer], click on the down-pointing arrow next to
[Name], then click on the driver to be used for output. At the [Print] dialog box you can make settings for the
items such as the printing range, orientation, and number of copies. To make settings for the cutting area and the
tool, click [Properties]. For more information on the Properties settings, refer to the help screens for the driver.

 Tool bar：
 Keyboard shortcut: [Ctrl]+[P]

[File] - [Print Preview] command

This displays what the results of printing will look like, so you can check your work before actually performing
printing. Running this command changes the display from the object's edit screen to the preview screen.

Preview screen commands
Print... This performs printing. The [Print] dialog box appears.
Page Setup... This allows you to make settings for paper size, margins, and the like. The [Page Setup] dialog

box appears.
Zoom In This enlarges the view size of the print image.
Zoom Out This reduces the view size of the print image.
Close This closes the Preview screen for printing.

[File] - [Print Setup...] command

This is used to select the driver and make the setting for orientation. The [Print Setup] dialog box appears. To
output data, then for [Printer], click on the down-pointing arrow next to [Name], then click on the driver to be
used for output. To make settings for the cutting area and the tool, click [Properties]. For more information on the
Properties settings, refer to the help screens for the driver.
The settings made here are temporarily saved. The changes are lost when you quit Dr. STIKA PLUS.

[File] - [Tiling] command

When the data is larger than the cutting area, this is used to split the data for cutting on two pieces of material
instead of one. When the tiling output is set, the two pieces of material are displayed, separated by a dotted line.
The cutting area for a single piece of material is set with the driver.

This is selected when tiling is not to be performed.  When Dr. STIKA PLUS is run for the first time, the setting
in effect is for [1 Page]

This is selected when data that is larger than the cutting area is to be split into two pages and output.
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[File] - [Exit] command

This ends the program.
If changes made to the file being edited have not been saved, a dialog box asking if you wish to save the changes
is displayed.

 Shortcut:

Click the button for closing the application window.
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5-3 [Edit] menu

[Edit] - [Undo] command

This erases the change just made and returns to the previous form.
Only the operation most recently performed can be undone.  It is not possible to undo earlier changes.

 Keyboard shortcut: [Ctrl]+[Z]

[Edit] - [Cut] command

This deletes the selected object, and copies it to the clipboard. The contents of the clipboard are maintained until
another object is copied to the clipboard. To paste the clipboard contents, run the [Edit] - [Paste] command.

 Tool bar：
 Keyboard shortcut: [Ctrl]+[X]

[Edit] - [Copy] command

This copies the selected object to the clipboard. The contents of the clipboard are maintained until another object
is copied to the clipboard. To paste the clipboard contents, run the [Edit] - [Paste] command.

 Tool bar：
 Keyboard shortcut: [Ctrl]+[C]

[Edit] - [Paste] command

This copies the contents of the clipboard, pasting them at the selected on-screen location. Only Dr. STIKA PLUS
objects can be pasted. Objects created with other applications cannot be pasted via the clipboard.

 Tool bar：
 Keyboard shortcut: [Ctrl]+[V]

[Edit] - [Delete] command

This deletes the selected object. The deleted object is not copied to the clipboard.

 Keyboard shortcut: [Delete]

[Edit] - [Select All] command

This selects all objects displayed on screen.

 Keyboard shortcut: [Ctrl]+[A]
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5-4 [View] menu

[View] - [Zoom] - [Zoom In] command

This displays an enlarged view of the object.

 Tool bar：
 Keyboard shortcut: [Ctrl]+[Page Down]

[View] - [Zoom] - [Zoom Out] command

This displays an reduced view of the object.

 Tool bar：
 Keyboard shortcut: [Ctrl]+[Page Up]

[View] - [Zoom] - [Custom] command

This specifies the ratio for enlarging or reduced the view of the object. Running this command opens the [Select
Zoom] dialog box.

[Select Zoom] dialog box

Zoom
Enter the view ratio as a percentage.
Any integer from 1 to 800 can be entered.

Slider
Dragging this slider up or down changes the view ratio. Any integer from 1 to 800 can be entered.

[View] - [Toolbar] command

This toggles the display of the toolbar on or off. The toolbar is provided with buttons for running Dr. STIKA
PLUS commands such as [Open...] and [Save As...]. Moving the mouse pointer over a button displays the button's
name. Toggling off the display of the toolbar enlarges the area of the edit screen.
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[View] - [Object Info] command

This toggles the display of the object information bar on or off. The object information bar shows the position of
the mouse pointer, as well as the object's centerpoint, dimensions, angle, and slant. Toggling off the display of the
object information bar enlarges the area of the edit screen.

[View] - [PenColor] command

This toggles the display of the color palette on or off. The color palette is used to change the color of an object's
lines Select the object, then click on the desired palette color.

[View] - [Status Bar] command

This command toggles display of the status bar window on or off.
The status bar shows helpful comments amount commands.  We recommend leaving the status bar on until
you're familiar with how Dr.STIKA PLUS works.
Turning off the status bar enlarges the object's display area.

[View] - [Show Grid] command

This toggles the display of the grid on or off. When Dr. STIKA PLUS has just been installed, thee grid is shown
with a spacing interval of 5 mm (0.2 inch).

[View] - [Snap To Grid] command

When this is on, objects are automatically aligned with the grid lines. Alignment with the grid lines can make it
easier to arrange two or more objects are make settings for object size. When Dr. STIKA PLUS has just been
installed, this function is off.

[View] - [Grid Setup...] command

This makes the settings for grid interval, whether the grid is displayed, and whether the snap to grid function is on
or off. Running this command displays the [Grid Setup] dialog box.
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[Grid Setup] dialog box

Horizontal
Enter the interval for horizontally adjacent grid lines. When Dr. STIKA PLUS has just been installed, this is set
at 5.0 mm (0.2 inch).
Setting range: 0.00 to 250.00 mm (0 to 9.84 inch)

Vertical
Enter the interval for vertically adjacent grid lines. When Dr. STIKA PLUS has just been installed, this is set at
5.0 mm (0.2 inch).
Setting range: 0.00 to 250.00 mm (0 to 9.84 inch)

Show Grid
This toggles the display of the grid on or off.

Snap To Grid
This toggles the function for snapping objects to the grid on or off.

Line
The grid is shown with dotted lines.

Point
The grid is shown with unbroken lines.
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5-5 [Object] menu

[Object] - [Text] command

This is used to enter a block of text to be cut. Running this command changes the mouse pointer to the text-editing
tool (  ).Click at the point where text is to be inserted, and use the keyboard to enter the block of text to be cut.
Use the keyboard to enter the text to be cut. The entered text is outlined, and the outlined text is displayed. The
only fonts that can be used with Dr. STIKA PLUS are TrueType fonts registered in Windows.
It's also possible to add or delete text to or from a block of text that has been entered.

 Tool bar：

[Object] - [Rectangle] command

This is used to create a square or rectangle by dragging to the desired location. Running this command changes
the mouse pointer to the shape-drawing tool (  ).

 Tool bar：

[Object] - [Round Rectangle] command

This is used to create a square or rectangle with rounded corners by dragging to the desired location. Running this
command changes the mouse pointer to the shape-drawing tool (  ).

 Tool bar：

[Object] - [Ellipse] command

This is used to create a circle or ellipse by dragging to the desired location. Running this command changes the
mouse pointer to the shape-drawing tool (  ).

 Tool bar：

[Object] - [Star] command

This is used to create a star by dragging to the desired location. Running this command changes the mouse pointer
to the shape-drawing tool (  ).

 Tool bar：
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[Object] - [Polygon] command

This is used to create a polygon by clicking on the apices. When finished creating the polygon, double-click on
the end point. While creating a polygon, clicking the right mouse button or pressing [Esc] deletes the apex.

 Tool bar：

[Object] - [Symbols] command

This adds a symbol to the file being edited.
Running this command opens the [Symbol] dialog box.

[Symbol] dialog box

Tab
The symbol and group names appear. Click the tab and select the group.

Symbol name
The name of the selected symbol is displayed. Entering a symbol name selects the specified symbol.

List of symbol name
A list of symbol names is displayed. Click on the name of a symbol to select it.

List of symbol shapes
A list of symbol shapes is displayed. Click on a symbol to select it.

Delete Symbol
This deletes the selected symbol.
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Group Setup
This changes the name of the currently selected group. The [Change Group Name] dialog box appears. Enter
the name of the group in the dialog box.

Delete Group
This deletes the currently selected group. Any symbols registered in the group are all deleted as well.

[Object] - [Add Symbol] command

It is used to register a symbol with a Dr. STIKA PLUS object.
Running this command opens the [Add Symbol] dialog box.

[Add Symbol] dialog box

Group Name
Select the group where the symbol is to be registered. Click to display a list of existing group names. To add a
new group, click [New Group].

Symbol Name
Enter the symbol name for the selected object.

Add
The selected object is registered as a symbol.

New Group
This adds a new group for the symbol. The [New Group] dialog box appears. Enter the name of the group in the
dialog box.

[Object] - [Properties] command

This is used to change the form of an object by modifying its numerical values. A dialog box for changing the
shape appears. The items displayed vary according to the type of object selected.

 Keyboard shortcut:： [Alt]+[Enter]
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Text Properties

Width
Enter the object's width.
The width is the dimension in the horizontal direction of the screen.

Height
Enter the object's height.
The height is the dimension in the vertical direction of the screen.

Aspect
Enter the object's aspect (vertical/horizontal ratio), with the aspect when the object was created taken to be 1.
Entering a numerical value when [Keep Aspect for input] is off causes the [Width] dimension to increase with
no change in [Height]. Entering 2 causes [Width] to double, and entering 0.5 reduces [Width] by half. Entering
a numerical value when [Keep Aspect for input] is on makes [Width] and [Height] change while maintaining
the same aspect.

Keep Aspect for input
This causes an object's aspect to be maintained at a fixed value when a numerical value is are entered for
[Height] or [Width]. When a value is entered for [Height] (or [Width]), the value of [Width] (or [Height])
changes automatically.

Angle
Enter the angle of rotation for the object. A negative angle may also be entered. Entering a negative angle
rotates the object clockwise.

Slant
Enter the degree of slant of the object. The unit is in degrees. Entering a positive angle makes the object slant to
the right. Entering a negative angle makes the object slant to the left.

Spacing
Enter the pitch (interval) for adjacent characters. Character size does not change.

Font
This displays the name of the selected font.
To change the font for the text, click on the down-pointing triangle.

Character
Dragging the slider changes the thickness (weight) of text. A font cannot be made narrower than its standard
weight. The left-hand end of the slider is standard weight, and the right-hand end is maximum weight.
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Rectangle properties

Width
Enter the object's width.
The width is the dimension in the horizontal direction of the screen.

Height
Enter the object's height.
The height is the dimension in the vertical direction of the screen.

Angle
Enter the angle of rotation for the object. A negative angle may also be entered. Entering a negative angle
rotates the object clockwise.

Slant
Enter the degree of slant of the object. The unit is in degrees. Entering a positive angle makes the object slant to
the right. Entering a negative angle makes the object slant to the left.

Preview
This displays the shape of an object.
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Round rectangles Properties

Width
Enter the object's width.
The width is the dimension in the horizontal direction of the screen.

Height
Enter the object's height.
The height is the dimension in the vertical direction of the screen.

Angle
Enter the angle of rotation for the object. A negative angle may also be entered. Entering a negative angle
rotates the object clockwise.

Slant
Enter the degree of slant of the object. The unit is in degrees. Entering a positive angle makes the object slant to
the right. Entering a negative angle makes the object slant to the left.

Shape
Drag the slider to change the shape of the object.

Preview
This displays the shape of an object.
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Circle or ellipse properties

Width
Enter the object's width.
The width is the dimension in the horizontal direction of the screen.

Height
Enter the object's height.
The height is the dimension in the vertical direction of the screen.

Angle
Enter the angle of rotation for the object. A negative angle may also be entered. Entering a negative angle
rotates the object clockwise.

Slant
Enter the degree of slant of the object. The unit is in degrees. Entering a positive angle makes the object slant to
the right. Entering a negative angle makes the object slant to the left.

Shape
Drag the slider to change the shape of the object. Polygons can be created.

You can make a polygon having from three sides (a triangle) to thirteen. Dragging the slider to the right-hand
edge creates a circle instead of a polygon.

Preview
This displays the shape of an object.



41

Star properties

Width
Enter the object's width.
The width is the dimension in the horizontal direction of the screen.

Height
Enter the object's height.
The height is the dimension in the vertical direction of the screen.

Angle
Enter the angle of rotation for the object. A negative angle may also be entered. Entering a negative angle
rotates the object clockwise.

Slant
Enter the degree of slant of the object. The unit is in degrees. Entering a positive angle makes the object slant to
the right. Entering a negative angle makes the object slant to the left.

Shape
Drag the slider to change the number of apices.

Dragging the slider to the left-hand edge creates a triangle. Each tick-mark to the right increases the number of
apices by one. You can create a star having up to 29 apices.

Preview
This displays the shape of an object.
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Polygon properties

Width
Enter the object's width.
The width is the dimension in the horizontal direction of the screen.

Height
Enter the object's height.
The height is the dimension in the vertical direction of the screen.

Aspect
Enter the object's aspect (vertical/horizontal ratio), with the aspect when the object was created taken to be 1.
Entering a numerical value when [Keep Aspect for input] is off causes the [Width] dimension to increase with
no change in [Height]. Entering 2 causes [Width] to double, and entering 0.5 reduces [Width] by half. Entering
a numerical value when [Keep Aspect for input] is on makes [Width] and [Height] change while maintaining
the same aspect.

Keep Aspect for input
This causes an object's aspect to be maintained at a fixed value when a numerical value is are entered for
[Height] or [Width]. When a value is entered for [Height] (or [Width]), the value of [Width] (or [Height])
changes automatically.

Angle
Enter the angle of rotation for the object. A negative angle may also be entered. Entering a negative angle
rotates the object clockwise.

Slant
Enter the degree of slant of the object. The unit is in degrees. Entering a positive angle makes the object slant to
the right. Entering a negative angle makes the object slant to the left.

Close Polyline
When on, polygons are closed. This is actuated when creating polygons. A shape whose start point and end
point coincide is caused a "closed shape." When [Close Polyline] is off, it results in an open shape that is a
polygon with one side erased.

[Object] - [Font] command

This is used to select the font for a block of text. Running this command opens the [Font Select] dialog box. When
a block of text has been selected, this command sets its font. When no text is selected, this command sets the font
used when test is entered.
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[Font Select] dialog box

Font
This displays the selected font.
Choosing a font from the font list makes the display change. Clicking [OK] changes the font setting to the one
displayed here.

Font Table
This displays the fonts available for selection. Click on a font in the list to choose it. Only TrueType fonts
registered in Windows are displayed.

Preview
This displays the form of the selected font.

[Object] - [Text Style] command

This setting determines whether the selected text is written vertically or horizontally.

[Object] - [Text Style] - [Horizontal] command

The selected block text of text changes to a horizontal layout.

 Tool bar：

[Object] - [Text Style] - [Vertical] command

The selected block text of text changes to a vertical layout.

 Tool bar：
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[Object] - [Move To Front] command

This changes the front-back relationship of the objects. The selected object is moved to the front.

 Tool bar：
 Keyboard shortcut:： [Shift]+[Page Up]

[Object] - [Move To Back] command

This changes the front-back relationship of the objects. The selected object is moved to the back.

 Tool bar：
 Keyboard shortcut:： [Shift]+[Page Down]

[Object] - [Align] command

All selected objects are aligned at their centers.

[Object] - [Mirror] command

This flips an object from left to right, creating a mirror image. This command is useful when you wish to view a
sticker from its side of application. For example, this command can be used for a sticker to be applied to the inner
side of a show window to make sure the text and shapes are correct when viewed from the correct side.

[Object] - [Convert to Polygon] command

This changes the attribute for an object other than a polygon to the attribute for a polygon. Converting an object to
a polygon with this command makes it possible for you to edit its points (apices).
Once an object has been converted to a polygon, it cannot be returned to its original attribute (text, rectangle,
rounded rectangle, circle/ellipse, or star).

[Object] - [Combine Polygon] command

A number of objects can be grouped together and united into a single polygon. They can then be moved or resized
while maintaining the layout the objects had before they were joined together. The points of an object polygon
that has been joined together in this fashion can be edited in the same way as an ordinary polygon.



45

[Object] - [Break Apart] command

A polygon can be split into individual parts.

5-6 [Help] menu

[Help] - [Contents] command

This displays the contents page for online help.

[Help] - [About...] command

This displays the version number and copyright information for Dr.STIKA PLUS.
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Part 6 If You Think There's a Problem...

6-1 Dr.STIKA PLUS doesn't function.

Does the computer you're using provide the correct operating environment for Dr.STIKA PLUS?

Check the conditions for the Dr.STIKA PLUS operating environment and make sure that the computer offers a
suitable environment.

Was the software installed using the setup program?

The setup program puts the files for Dr.STIKA PLUS in the necessary locations to enable the software to be used
under Windows.

6-2 Uncut areas remain, or areas are not cleanly cut.

Is the amount of blade extension correct?

The amount of blade extension that has been set is too short for the material being used.  Increase the extended
length of the blade to the same thickness as the sheet portion.  For information on how to adjust the amount of
blade extension, refer to the user's manual for the cutting machine.

Is the blade broken?

Replace with a new blade.
For information on how to replace this, refer to the user's manual for the cutting machine.

6-3 The results of cutting are displaced, and uncut portions

Is the amount of blade extension correct?

The amount of blade extension that has been set is too long for the material being used. Increase the extended
length of the blade to the same thickness as the sheet portion.  For information on how to adjust the amount of
blade extension, refer to the user's manual for the cutting machine.

Is the cutting speed correct?

The cutting speed is too fast. Reduce the cutting speed.
If the cutting speed cannot be set on the cutting machine, make the setting for the driver.
Please refer to the relevant help screens for the driver to set the cutting speed.

Has the material size been set correctly?

Material smaller than the set cutting range has been loaded.  Load material that matches the cutting range.
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6-4 Error Messages

"XXXXX Illegal Font Select"

The Dr. STIKA PLUS file you tried to open contains fonts that are not registered in Windows.  When this
happens, a list of substitute fonts is displayed.  The file may have been made on a machine with a different font
environment, or some fonts may have been deleted from Windows.  To reproduce the original image, make sure
the necessary fonts are installed.

"Not enough memory"

If insufficient memory occurs during processing, close all other applications or restart Windows.
If the message about insufficient memory still appears, check the amount of free space on your hard disk.
Windows normally uses a portion of the hard disk for virtual memory, and it may be that there is not enough space
left on the hard disk.  If this is the case, free up space on the hard disk by deleting unneeded files or moving them
to another disk.  If the message about insufficient memory still appears after doing this, it is recommended that
you increase the amount of memory in your computer.

"Could not generate outline"

An outline could not be extracted because of the faint color of data imported using a scanner or Windows bitmap
data imported with the [Import] command.  Adjust the data to a darkness that allows an outline to be extracted
and import the data again.

"Unexpected file format"

A file opened with the [Open] command or imported with the [Import] command is in a format that Dr. STIKA
PLUS does not recognize.  Use a file format that Dr. STIKA PLUS can recognize.

File formats that can be imported
Windows Bitmap ：Extension *.bmp ([Import] command only)
Dr.STIKA PLUS ：Extension *.stx
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Appendix

Glossary

Object
This is the collective name for shapes and blocks of text. The lines which are actually cut are displayed.

Dr. STIKA PLUS File
This is a file saved in Dr. STIKA PLUS format. Normally the file extension ".stx" is used for such files.

BMP
BMP (Windows bitmap) is a standard graphical file format for Windows. It can be used to store bitmap data. All
graphics are represented as a collection of dots.

WMF
WMF (Windows Meta File) is a data format used to enable different software applications to exchange data.
The Windows Meta File format can be used to save files in a mixture of bitmap data and vector data.  For this
reason, this file format is supported by examples of both draw-type software for making line drawings and other
illustrations and paint-type software used mainly for image data such as photographs.
Dr. STIKA PLUS converts vector data in a Windows Meta File to line information.  Any bitmap data in such a
file is ignored.

TrueType Font
This is one type of outline font system that represents text as an outline and a filled portion.  It is provided as
standard on Windows 95 or higher.

Vector Data
Vector data is a data format that represents images (text and shapes) as a set of reference points and the lines that
connect them.  Most draw-type software applications can be used to create vector-data images.

Bitmap Data
Bitmap data is a data format that represents images (text and shapes) as a collection of dots.  Most paint-type
software applications show images as bitmaps.

Resolution
This is a scale that indicates the precision of images displayed on screen, printed on the printer, or acquired with
the scanner.  The larger the number, the more detailed and attractive is the image it represents.

Gradation
This indicates the smoothness of changes in color when colors are used.

Clipboard
The clipboard is used to hold data temporarily when it is being copied or cut.  The clipboard is a standard feature
of Windows 95 or higher.
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